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Introduction
1 Introduction

Manufacturers have defined various useful MIB variables for their devices 
that are missing in a standard SNMP Get request. Therefore, Hirschmann 
Automation and Control GmbH's HiFusion also allows you to integrate 
manufacturer-specific MIB variables from third-party devices into the 
Management-Software, Industrial HiVision. For this, you create Product-
Specific Modules (PSM). When creating a PSM, you name the device, define 
a range of variables, and assign an image to the device. The execution of the 
process is largely automated. If you integrate the finished PSM in Industrial 
HiVision, the properties defined by you are available in Industrial HiVision. 
HiFusion works as an independent application, regardless of whether 
Industrial HiVision is installed. The program works without a license. The only 
prerequisite for incorporating non-Hirschmann Automation and Control 
GmbH MIB variables, is that the devices support version 1 or version 3 of the 
Simple Network Management Protocol (SNMP).

In this user manual, you find the following release notes:
 A guide to working with the software
 A description of the program user interface and its functions
 Step-by-step instructions for creating a PSM

The user manual teaches you the following skills:
 Creating your own PSMs
 Adapting existing PSMs
 Testing PSMs

Note: For readability purposes, this documentation uses the classic 
Windows view for screen shots.
PSM Generator Industrial HiVision
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Installation
2 Installation

This chapter describes
 System Requirements
 Installation under Windows
 Installation under Linux
 Maintenance
 Deinstallation under Windows
 Deinstallation under Linux
PSM Generator Industrial HiVision
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Installation 2.1 System Requirements
2.1 System Requirements 

HiFusion has the following requirements with regard to the hardware and the 
operating system of your computer.

 Hardware
 x86-compatible processor, 1 GHz or higher
 At least 1 GB of RAM, 2 GB recommended
 Disk space

2 GB free
 Monitor resolution of 1024 x 768 pixels

 Operating system
 Windows 7 (64 Bit)

Windows 8.1 Professional (64 Bit)
Windows 10 Version 1803 (64 Bit)

 PC Linux (64 Bit: Kernel 3.10, libc 6)
Debian 8
Debian 9
Debian 10
Red Hat 7
Red Hat 8

Note: Debian Linux: Install the packages libmono2.0-cil and libmono-
winforms2.0-cil.
10
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Installation 2.2 Installation under Windows
2.2 Installation under Windows

 Open the Hirschmann HiFusion web site:
 https://catalog.belden.com/index.cfm?event=pd&p=PF_HiFusion

 Click "Resources".
 Select the "HiFusion - Windows Version> Download" link.
 Extract the zipped files.
 Navigate to the location of the extracted files.
 Double click the hifusion04500_windows.exe file.
 Answer the questions of the installation script and follow its instructions. 

If you do not answer a question of the installation script, the installation 
script selects the default answer. 
PSM Generator Industrial HiVision
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Installation 2.3 Installation under Linux
2.3 Installation under Linux

 Open the Hirschmann HiFusion web site:
https://catalog.belden.com/index.cfm?event=pd&p=PF_HiFusion

 Click "Resources".
 Select the "HiFusion - Linux Version> Download" link.
 Unpack the hifusion04500_linux.tar file using the following command:

tar -xf hifusion04500.tar -C /path/to/directory
 Start the installation script with the command

sh /path/to/directory/linux/install.sh
 Answer the questions of the installation script and follow its instructions. 

If you do not answer a question of the installation script, the installation 
script selects the default answer.
12
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Installation 2.4 Deinstallation under Windows
2.4 Deinstallation under 
Windows

 Quit the HiFusion program before you start the deinstallation.
 To deinstall HiFusion, select 

Start:Control Panel:Software.
 Select the HiFusion program.
 Click "Change/Remove" and follow the instructions of the deinstallation 

routine.
PSM Generator Industrial HiVision
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Installation 2.5 Deinstallation under Linux
2.5 Deinstallation under Linux

 Quit the HiFusion program before you start the deinstallation.
 Logon with the su command so that you have root access rights.
 Delete the /opt/hifusion4.5 directory with the command rm -rf /

opt/hifusion4.5 
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Installation 2.6 Maintenance
2.6 Maintenance

Hirschmann is continually working on improving and developing their 
software. Check regularly whether there is an updated version of the 
software that provides you with additional benefits. You find information and 
software downloads on the Hirschmann product pages on the Internet 
(https://www.belden.com).
PSM Generator Industrial HiVision
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Starting the application
3 Starting the application
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Starting the application 3.1 Starting under Windows
3.1 Starting under Windows

To start the program, double-click the program icon on the desktop. 
Alternatively, you can find a link to the program in the Start menu and in the 
installation directory.
18
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Starting the application 3.2 Starting under Linux
3.2 Starting under Linux

 You start the program with the command
/opt/hifusion4.5/bin/hifusion
PSM Generator Industrial HiVision
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Starting the application 3.2 Starting under Linux
20
PSM Generator Industrial HiVision

Release 04.5.00 03/2024



Interface of the program
4 Interface of the program

This chapter describes the program interface of HiFusion. It provides you 
with an overview of the buttons to help you find your way through the 
graphical interface. At the same time, this chapter explains a number of 
principles to you on which the program is based.

After reading this chapter, you will be familiar with the following subjects:
 the interface of the program,
 the buttons and their functions,
 a number of principles on which the program is based.

You control the functions of HiFusion using tabs and menus. The following 
chapters describe the tabs and menus and their functions.

Figure 1: Menu bar and tabs of HiFusion
1 – Menu bar
2 – Tabs
PSM Generator Industrial HiVision
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Interface of the program 4.1 Menu bar
4.1 Menu bar

HiFusion has a menu bar with multiple menus. You use the menu bar to 
control the functions of the program.

The following menus are available to you:
 File
 PSM
 Language
 Tools
 Help

Figure 2: Menu bar
22
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Interface of the program 4.1 Menu bar
4.1.1 File

When you have several PSMs to create, the File menu allows you to create 
new PSMs without restarting the HiFusion program. Furthermore, the menu 
also allows you to open previously saved PSMs projects.

The following buttons are available to you in the File menu:
 New PSM

This button allows you to start creating a new PSM without restarting the 
HiFusion program.

 Open
Using this button allows you to browse to the location an existing PSM 
project saved during a previous session and open the PSM project. 

 Save
You save an ongoing PSM/PSM project. The first time you save the file 
HiFusion opens a browsing window allowing you to save the file in a 
selected location. You save subsequent changes to this file. The file is 
saved as a zip file. 

 Save as...
You save an ongoing PSM/PSM project in a selected location. The file is 
saved as a zip file. It is strongly recommended that the file name remain 
the same as it is displayed in the dialog. The digits at the end of the file 
name are the digits you entered as the PSM version number.

 Exit
You exit the HiFusion PSM Generator, any unsaved work is lost.
When you click Exit the application exits without confirmation only if 
there are no changes. 
If you open and modify a PSM and you click Exit, a popup dialog opens 
allowing you to select save changes, discard or cancel.
PSM Generator Industrial HiVision
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Interface of the program 4.1 Menu bar
4.1.2 PSM

The PSM menu contains options that allow you to verify that the PSM you 
created, functions properly.

The following buttons are available to you in PSM menu:
 Check PSM

Checks whether the created PSM is plausible. HiFusion checks, for 
example, whether you have filled in the relevant fields.
When HiFusion detects an error in the PSM, then the program displays 
the Errors and Warnings dialog describing the severity, reason and 
location for the detected error.
After you correct and recheck the detected errors, HiFusion displays a 
message window informing you that the PSM is ready for testing.

 Test PSM...
Opens the Test PSM dialog containing the following radio buttons used 
for testing your PSM in different environments: 
– Virtual device

HiFusion includes a built-in test environment. This means that you can 
test your PSM without using Industrial HiVision. If you use Industrial 
HiVision to test your PSM save the Industrial HiVision configuration.
The option, “Internal agent” uses the MIB dump created in the current 
PSM project. 
If you have a MIB dump of a device from the same family, then you can 
also test the file by selecting the file in the “Custom agent dump file” 
field.

– IP of real device
 In the text field, specify the IP address of a device which uses the 
same MIBs as contained in your PSM project. After creating the PSM 
you can test the PSM with a real device. If you changing the values in 
the device, then the values in the table change after a Rescan. The 
Kernel dialog contains the Rescan button.

– The dialog contains the following buttons:
Test
Application generates a virtual PSM, then opens the Kernel dialog 
allowing you to view the parameters and their values. 
When testing the PSM using the virtual agent, HiFusion reads the 
values that are present in PSM dump file.
When testing the PSM using a real device, HiFusion reads the values 
of the device.
Close
Exits the Test PSM window. 
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Interface of the program 4.1 Menu bar
 Generate PSM...
Opens the Generator Settings dialog, allowing you to save the PSM 
project and generate the PSM. It is strongly recommended that you do not 
change the file name. The digits at the end of the file name are the digits 
you entered as the PSM version number.
The dialog contains the following fields:
– Save PSM project

Checkbox marked, saves the PSM project and generates the PSM. 
The text field allows you to specify the desired location for your PSM 
zip file. 

Checkbox unmarked, only generates the PSM. 
– PSM Location

The text field allows you to specify the desired location for your PSM 
file. The extension of the PSM is “ihvpsm“.

4.1.3 Language

HiFusion allows you to set the interface dialog to several different languages. 
Select the language that best suites you from the menu.

The following languages are available:
 English
 Italian
 Korean
 Portuguese
 Greek
 Indonesian
 Spanish
 French
 Japanese
 German
 Russian 
 Chinese
PSM Generator Industrial HiVision
Release 04.5.00 03/2024 25



Interface of the program 4.1 Menu bar
4.1.4 Tools

The menu allows you to view the values of MIB variables available on device. 

The following list describes the available options:
 MIB Viewer

The menu item opens the MIB variable selector dialog allowing you to 
verify the MIBs that you entered into the PSM project. The MIB Viewer 
has a copy and paste function making it possible to copy any cell in the 
dialog, and then paste that information into a planning tool.
– Search

The text field allows you to search through the table for a specific MIB 
variable. 

– The table lists the MIB information in the following columns:
MIB variable name, identifies the name of the MIB object.
Value, the value of the variable.
Type, lists the MIB object type.
Description, the description of the MIB variable as defined in the 
MIB.
MIB, displays the name of the MIB.

 Update dump
The menu item opens a browser allowing you to navigate to an existing 
dump file saved during a previous session. After a firmware update, new 
OIDs are available for the device. Updating an existing dump file allows 
you to include the new OIDs in an existing project.

4.1.5 Help

The following menu items are available to you in the Help menu:
 Online Help

Opens the online help menu allowing you to search through the various 
subjects.

 Belden Website
Opens your browser and navigates to the Belden website.

 About
Opens a text window which displays the latest program information for 
example, the release level.
26
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Interface of the program 4.2 Tabs
4.2 Tabs

The tabs allow you to view and change the various properties in the PSM 
project. 

The following tabs are available to you:
 PSM
 MIBs
 Device
 Port Generation
 Properties
 Traps
 Translations
 MultiConfig™

Figure 3: Tabs
PSM Generator Industrial HiVision
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Interface of the program 4.2 Tabs
4.2.1 PSM

The PSM tab contains basic parameters of your PSM. You define the 
parameters when you create a PSM. Industrial HiVision displays some of the 
parameters after importing the PSM into the program.

The parameters contained in the tab include:
 Name

Specify the name of the new PSM. When specifying the name of the PSM 
either write the words together, or use an underscore _ for separation. 
Furthermore, when creating the name, the same characters restrictions 
apply as when you name a folder in a directory.

 Label
Specify the PSM name which Industrial HiVision displays.

 Description
The description allows your to readily identify the PSM.

 Copyright
To maintain the copyright of your PSM, specify the legal or natural person 
who owns the copyright. The copyright is a composition of the 
manufacturer name and the current year.

 Creator
Specify the author of the PSM.

 Vendor
The manufacturer of the device for which the author generated the PSM. 
The program does not allow Hirschmann to be identified as the 
manufacturer. Industrial HiVision displays this parameter.

 Software Conditions
Specify the conditions under which other people are allowed to use the 
PSM.
28
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Interface of the program 4.2 Tabs
 Version
Specifies the version number of the PSM. Enter a three digit number, 
without a point “.“. Industrial HiVision adds the point automatically. For 
example, Industrial HiVision displays 100 as 1.00. Use the version 
number to keep track of each edition of your PSM. To maintain an 
overview of your PSMs, create a list containing the appropriate 
information regarding your PSMs.
Industrial HiVision displays this parameter.

 The PSM tab contains the following buttons:
– Save preset

Opens a browser allowing you to save the information entered in the 
Load preset tab in a location of your chose. Extension of this file is 
“hud” (Industrial HiVision User Data).

– Load Preset
Opens a browser allowing you to navigate to a “.hud” file and populate 
the PSM tab with information saved in the “.hud” file.

4.2.2 MIBs

The Management Information Base (MIB) describes the information that the 
network management protocol reads via an SNMP Get request. MIBs have 
a tree structure. The tree structure consists of two areas: a standardized area 
and a manufacturer-specific private area (private MIB). In the private MIBs, 
manufacturers create separate MIB branches with manufacturer-specific 
properties.

Note: Every manufacturer sets up their own private MIB(s) and defines their 
own variables and tree structures. Manufacturers make the MIB(s) that relate 
to their devices for example, as a download on their devices or via the 
manufacturer website. Save the manufacturer-specific MIB(s) locally when 
creating a PSM for a device from this manufacturer.
PSM Generator Industrial HiVision
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Interface of the program 4.2 Tabs
The tab contains the following items:
 MIB Table

The table displays the MIBs loaded in the PSM project.
 Buttons

– Add
Opens the Choose MIBs dialog allowing you to navigate to the location 
where you saved a MIB which you load into the PSM project for 
example, a manufacturer-specific MIB.

– Remove
Removes the selected MIB from the PSM project.

4.2.3 Device

Industrial HiVision displays the values specified in the tab allowing you to 
identify the device.
30
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Interface of the program 4.2 Tabs
The dialog contains the following frames:
 Identification and Images

Specifies the device 
– Table

Sys OID
Displays the system object identifier of the MIB object. Industrial 
HiVision uses the parameter to identify the device type if no additional 
device identification is present.
Product Name
Specifies the name of the device which Industrial HiVision displays. 
HiFusion retrieves the product name directly from the device. 
Image
Displays the image of the device which Industrial HiVision displays. 
Additional device identification
Displays addition information used to identify the device. Using the 
Edit button you specify the parameter. You can use the wild card 
character “*” in the identifier.
Vendor Name
Specifies the name of the device manufacture. When you specify the 
vendor name, Industrial HiVision displays the value.

– The Edit button opens the Device identification dialog, allowing 
you to specify individual device parameters displayed in the 
Identification and Images table.

 SNMP Access Params
The frame displays the detected communication protocols and the SNMP 
access parameters. Industrial HiVision displays these passwords as clear 
text in the Preferences > Advanced > Device Credentials dialog. To 
avoid a possible security risk, change the access parameters to the 
default settings

Note: HiFusion stores these parameters in the generated PSM. Enter 
only the default passwords of the device. 

 Protocols
Specifies the communication protocols and the SNMP access 
parameters:
– Management protocols

Industrial HiVision adds the management protocols to the Protocols 
frame. 

– Supported protocols
Industrial HiVision uses the support protocols for enabling menu 
entries like CLI and GUI Interfaces for the device.
PSM Generator Industrial HiVision
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Interface of the program 4.2 Tabs
4.2.4 Port Generation

You use the Port Generation function to map the ports and modules. When 
you make a PSM for non-modular devices, use the PSM only on the non-
modular devices of the same type. When you make a PSM for modular 
devices, use the PSM only on modular devices of the same type. 

Note: This function is compatible with Industrial HiVision beginning with 
release 08.1.01.

 Default Port Generation
When you select the Default Port Generation radio button, HiFusion 
generates 1 port per interface. (Default setting).

 Non-Modular Devices
You use the Generate Ports function to map device ports. For example, 
when your device has 7 physical ports and other interfaces. You limit the 
number of ports that HiFusion maps. HiFusion thus, ignores the internal 
interfaces.

Figure 4: ifTable of a non-modular device with 7 physical ports

 To configure the ports, select the Generate Ports radio button.
 The Highest ifIndex field sets the number of ports HiFusion maps. 

To activate the Highest ifIndex field, mark the Highest ifIndex 
checkbox.

 In the Highest ifIndex field, enter 7 as the maximum number of 
physical ports that your device has.
32
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Interface of the program 4.2 Tabs
Figure 5: Port Generation > Highest ifIndex

If you have unordered physical ports as seen in figure 6, then Industrial 
HiVision displays the ports as port 2 and 3. To have Industrial HiVision 
display the ports as 1 and 2, you map the ports using the Mapping 
ifIndex - Port function. In this example, you map eth1 to port 1 and 
eth0 to port 2.

Figure 6: ifTable of a non-modular device with 2 unordered physical ports

 To configure the ports, select the Generate Ports radio button.
 To map the physical ports, mark the Mapping ifIndex - Port 

checkbox.
 To add port 2 to the mapping table, click the Add button. HiFusion 

opens the Add Port Mapping dialog.
 To configure instance 2 (eth0), enter 2 in the ifIndex field.
 To map instance 2 to port 2, enter 2 in the Port Number field.
PSM Generator Industrial HiVision
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Interface of the program 4.2 Tabs
 In the “Add Port Mapping“ dialog, click the Add button. HiFusion adds 
the information to the table.

 To add another port to the table, click the Add button again.

Note: Each time you click the Add button to open the Add Port 
Mapping dialog the number in the ifIndex and Port Number fields 
increase by 1.

 To configure instance 3 (eth1), verify that the ifIndex field contains 
the number 3.

 To map instance 3 to port 1, enter 1 in the Port Number field.
 In the Add Port Mapping dialog, click the Add button.

Figure 7: Port Generation > Mapping ifIndex - Port

 Modular Devices
You can configure a modular device that has the same number of physical 
ports on each module. The example device has 7 modules with 4 ports 
each. Other internal interfaces are present in the device, such as the CPU 
interface. You only map the 28 physical ports.
34
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Figure 8: ifTable of a modular device with 28 physical ports

 To configure the ports, select the Generate Ports radio button.
 To activate the Highest ifIndex field, mark the Highest ifIndex 

checkbox.
 In the Highest ifIndex field, enter 28 as the maximum number of 

physical ports on your device.
 To configure the modules, select the Generate Modules checkbox.
 To set the number of ports per module, mark the Ports per Module 

checkbox.
 In the Ports per Module field, enter 4 as the number of physical ports 

on each module.
PSM Generator Industrial HiVision
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Interface of the program 4.2 Tabs
Figure 9: Port Generation > Generate Modules/Ports per Module

You can also use the Port Generation function for unique modular 
devices with a different number of ports per module. In this example, you 
configure port mapping for a device with 2 modules. The first module 
contains 16 ports and the second module contains 8 ports. The main 
device contains the first 4 ports.

Figure 10: ifTable of a modular device without the same number of port per module

 To configure the ports, select the Generate Ports radio button.
 To configure the modules, select the Generate Modules checkbox.
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 To map the physical ports, select the Mapping ifIndex - Port 
checkbox.

 To add instance 5 to the mapping table, click the Add button. 
 To configure instance 5, enter 5 in the ifIndex field.
 To map instance 5 to module 1, enter 1 in the Module Number field.
 To map instance 5 to port 1, enter 1 in the Port Number field.
 In the Add Port Mapping dialog, click the Add button.
 To add another port to the table, click the Add button again.
 Continue to add the other ports on module 1.
 To add module 2 to the table, click the Add Module button.

Note: Each time you click the Add Module button to open the Add 
Port Mapping dialog the number in the ifIndex and Module Number 
fields increase by 1. HiFusion enters the number 1 in the Port Number 
field.

 To configure instance 21, enter 21 in the ifIndex field.
 To map instance 21 to module 2, verify that the Module Number field 

contains the number 2.
 To map instance 21 to port 1, verify that the Port Number field contains 

the number 1.
 In the Add Port Mapping dialog, click the Add button.
 Continue to add the other ports on module 2.
PSM Generator Industrial HiVision
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Interface of the program 4.2 Tabs
Figure 11: Port Generation > Generate Modules/Mapping ifIndex - Port

4.2.5 Properties

After a device request, you will see the supported device parameters.
The tab allows you to edit the following areas:
 Device tree
 Features
 Property type
 Mapping
 Advanced settings

You activate the Advanced settings fields by marking the checkbox.
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 Device tree
In the Device tree area of the Properties tab, you create new and 
remove properties in your PSM.
Right clicking on an item displays a menu allowing you perform the 
following tasks:
 New property, add a property to the device.
 Remove, delete a property from the device.
 Expand all, displays the complete list of properties on a device.
 Collapse all, hides every device property except the first sub-level.

 Features
The Features frame in the Properties tab contains the features 
supported by your device. You only change the supported features if you 
know that your device has a property that Industrial HiVision has detected 
incorrectly.

 Property type
In the Property typearea on the Properties tab, you define the 
following:
 Name

You specify an internal name for the property. HiFusion displays the 
translation of the associated token in the Device tree.

 Token
Specifies the device token associated with the property. You can 
change the token description in the Translations tab.

 Image
The text field displays the image assign to the property.
The Select button allows you to navigate to an image and assign the 
image to the property.

 MIB Variable
The test field displays the MIB variable assign to the property.
The Select button opens the MIB selector dialog allowing you to 
select an MIB object and assign the object to the property.
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 Instance
 Fixed assignment: You enter a fixed value.
 Variable: From the drop-down list, you select a variable from which 

HiFusion contains the instance.
 Data type
 String

A text value for example, system name.
 Integer

A whole number.
 Float

A decimal number for example, 1.6.
 Enum

The value allows you to map the outcome of an operation into a 
meaningful answer for example, 0=No Error, 1=Error.

 MAC Address
Specifies the data type as a MAC address.

 IP Address
Specifies the data type as an IP address.

Note: The selection in the Data type field restricts or expands your 
options for the following input fields on the Properties tab. HiFusion 
proposes a data type for the selection of an MIB variable. You only 
change the data type if you know that the variable has another data type.

 Mapping
The Mapping frame gives you the following options:
 Map a received value to the displayed value:

The MIB variable contains a selection of possible (numeric) values that 
cannot be interpreted in pure form. During the mapping, you assign 
various interpretable statuses to the various numeric values. Only the 
Enum data type enables a mapping to be created.

 Convert figures using factor and offset:
The MIB variable supplies figures in a specific format, but you require 
the figures in a different format. Only the Integer and Float data 
types allow you to convert the figures. The program uses the linear 
equation (y = a × x + b) for the calculations. Here “a” is the factor, 
“b” the offset, “x” the value in the agent, and “y” the value in HiFusion.
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 Advanced settings
The Advanced settings frame allows you to specify how Industrial 
HiVision monitors and displays the PSM. 
When you mark the Advanced settings checkbox, the functions in the 
frame are read-write. 
The frame has the following buttons and checkboxes:
 Visible

Specifies whether a property is visible.
 Variable

Specifies whether you can change the way Industrial HiVision handles 
a property.
When you select the Variable checkbox, HiFusion allows you to 
change the Change after trap, Default polling interval, 
Status configuration and Calc status by default functions.

 Change after trap
Specifies whether you have the option to select the property and 
update it using traps on the Traps tab.

 Default polling interval
Specifies whether a property activates its polling after Industrial 
HiVision discovers a device, and at what interval.
Values have the following meanings:
 Value = 0: off
 Values > 0: interval in seconds

 Status configuration
Specifies whether you create a status configuration. Only variable 
properties have a status configuration.

 Calc status by default
Specifies whether a property calculates its status. To calculate the 
status, the property requires a status configuration. 

 Writable
If the property is writable, then the property dialog in Industrial HiVision 
enables the Write button. The user can set the MIB variable on the 
device. 

 Bubble help propagation
Specifies the number of levels on which Industrial HiVision propagates 
the value of this property. The more levels you enter here, the earlier 
you see the value in the bubble help.
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4.2.6 Traps

The Traps tab displays the traps that HiFusion found in the MIBs after a 
successful upload.
If you know the connection between an MIB variable and a trap, this tab 
allows you to change the value of the properties using traps. 
HiFusion allows you to change traps that you set Change after trap as 
active in the Advanced settings in the Properties tab.
 Monitor the trap that is important for your MIB variable.

Note: As an advanced user, you disable the superfluous standard error 
messages.

4.2.7 Translations

HiFusion adds the English explanatory text defined in the MIB to the traps 
found. The Translations tab displays the explanatory text when after you 
queried the device. HiFusion allows you to translate or modify the English 
explanatory text and save the translation. The PSM then contains the 
translation. HiFusion also allows you to translate the properties defined by 
you. You have the option of translating both the designation of the property 
and the values.
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4.2.8 MultiConfig™

The MultiConfig tab enables you to configure your PSM for MultiConfig™ 
dialogs of third party devices and ports. HiFusion displays the MultiConfig 
tab only for PSMs compatible with Industrial HiVision release 08.0.00 or 
above.
The MultiConfig™ function allows you to perform the following tasks:
 New property, create a new property for the device or port.
 Remove, delete a property from the device or port.
 Edit image, to edit the icon image of a property.
 Import from PSM, import properties from another PSM.
 Expand, displays the complete list of properties Collapse, hides every 

device property except the first sub-level.
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5 Creating a PSM

Hirschmann protects the PSMs delivered in Industrial HiVision by default. 
Industrial HiVision lists the PSM, depending on the manufacture, as 
“Trusted”. Furthermore, Industrial HiVision prohibits you from overwriting the 
PSMs from the manufacture with PSMs you create yourself. You can, 
however, create PSMs for devices without PSMs and import them into 
Industrial HiVision.

Creating a simple PSM is fairly easy, but to develop a more complex PSM 
requires knowledge of the following subjects:
 The Simple Network Management Protocol (SNMP),
 the structure of Management Information Bases (MIB) in general,
 the structure of the manufacturer-specific MIB from which you incorporate 

manufacturer-specific variables into your PSM.

This chapter gives you step-by-step instructions for creating a PSM. Before 
you import a PSM into your operational Industrial HiVision system, save the 
Industrial HiVision project file. You can do this under the menu "File -> Save 
as" in Industrial HiVision.

Note: If you cannot import a MIB into HiFusion, then validate the MIB at http:/
/www.simpleweb.org/ietf/mibs/validate/upload.php. If HiFusion detects 
errors in the MIB, then contact the vendor for an updated version.

This main chapter contains the following sub-chapters:
 “New PSM wizard”
 “Define basic parameters”
 “SysOID and image”
 “Define properties”
 “Save a PSM project”
 “Create translations (optional)”
 “Check and test the PSM”
 “Change an existing PSM”
 “Make MultiConfig™ dialogs for PSMs”
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5.1 New PSM wizard

HiFusion provides you with a wizard to help create PSMs. When you start the 
HiFusion program you have the option of starting the wizard or opening an 
existing PSM. The wizard allows you to create a PSM by retrieving the MIB 
variables values form a dump or from a device. Advanced users can create 
a PSM from scratch, defining every MIB variable included in the PSM, but 
uploading a dump file into the wizard greatly simplifies the task. 

This chapter describes the work steps used when creating a PSM with the 
New PSM wizard:
 Start the New PSM wizard and load the device MIB(s).
 Manage the SNMP access parameters.
 Enter the IP address.
 Perform the device request.

5.1.1 Start the New PSM wizard

The wizard allows you to extract the dump file and MIBs variables directly 
from a device. The extracted file, dump file, can be helpful when creating 
PSMs for devices of the same family. When a device is unavailable, before 
you begin, obtain the manufacturer-specific MIB(s) variables from a suitable, 
official source then save the MIB(s) locally. 

To create a new PSM, perform the following work steps:
 Start the HiFusion program. After the program starts, the following options 

are available:
– "Create a new PSM"
– "Open an existing PSM"
– "Close HiFusion"
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 Open the New PSM wizard, click "Create a new PSM". 
HiFusion opens the "New PSM Wizard" dialog. The dialog allows you to 
specify the following parameters:
– "Industrial HiVision Version"

Specifies the Industrial HiVision start version for which the PSM is 
being created. 

– "IP address"
Specifies an IP address of a device available for MIB and "Dump file" 
extraction. After HiFusion completes the extraction HiFusion loads the 
device parameters in your PSM project and the wizard closes.

– "Dump file"
Specifies the location of the device dump file, in xml format, obtained 
from the manufacture.

– "Private MIBs"
Displays the manufacturer-specific MIB(s) and location of the MIB file 
saved previously.

– "SNMP Access Parameters"
The dialog allows you to specify the SNMP login parameters.
To activate the "Encryption" frame, select V3 from the "SNMP Version" 
drop down menu. You can select either No Encryption, DES or AES 
encryption.

 When you extract the MIB variables from a device HiFusion loads the 
MIBs variables directly into your PSM project. To load the manufacturer-
specific MIB(s) in the New PSM wizard, proceed as follows:
– Click "Add"

HiFusion opens the "Choose MIBs" window allowing you to navigate 
to the location of the manufacturer-specific MIB(s) that saved 
previously.

– Select the MIB(s) to enter in your project by either double clicking on 
the file, or highlighting the file(s) then clicking "Open".
HiFusion closes the wizard and opens the Device tab.

Note: A MIB may possibly have dependencies on other MIBs. HiFusion tries 
to resolve these dependencies itself by looking for the required MIB(s) in the 
same directory. If HiFusion does not find the MIB(s) causing the 
dependency, HiFusion outputs an error message with the name of the 
MIB(s). To resolve the error displayed, you make the MIB(s) available.
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5.1.2 SNMP access parameter management

The wizard allows you to change the SNMP access parameters if necessary.
The frame allows you to manage SNMP parameters as follows:
 add new SNMP parameters,
 edit existing SNMP parameters,
 delete existing SNMP parameters.

To add a new set of SNMP access parameters, you perform the following 
steps:
 Click "Add".

The "Add SNMP Credentials" dialog opens.
 Enter the user name or the password, or both.
 Click "Add".

HiFusion deletes the entry from the table.

Note: For SNMPv3 you require a user name and a password. For SNMPv1, 
leave the user name text field blank and enter the community name in the 
password field.

To edit an existing set of SNMP parameters, you perform the following steps:
 Select the entry to be edited.

HiFusion highlights the row in blue.
 Click "Edit"
 Change the user name or the password, or both.
 Click "OK".

HiFusion shows the changed SNMP access parameters in a table.

To delete an existing set of SNMP parameters, you perform the following 
steps:
 Select the entry.

HiFusion highlights the row in blue.
 Click "Delete"

HiFusion deletes the set of SNMP parameters from the table.
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5.1.3 Enter the IP address

For the PSM new wizard of HiFusion to identify your device, the PSM new 
wizard requires the IP address of the device. 
 Enter the IP address (v4) of your device.
 Click "Next".

After you click "Next", HiFusion opens the "Testing device reachability" 
window. HiFusion checks the reachability and the supported protocols of 
the device.
After the check, HiFusion opens the "SNMP Parameters" dialog with the 
discovered SNMP parameters.

Note: HiFusion allows you to change the SNMP parameters. Change the 
SNMP parameters only if you are very familiar with the device and know that 
the device has SNMP parameters different from the parameters that 
HiFusion discovered.

5.1.4 Perform the device request

To now request the device information, you perform the following step:
 Click "Finish"

HiFusion opens the "Perform request" window.

Note: Requesting the device information can take several minutes. In some 
cases, an agent has 40,000 values or more.

When you have carried out the steps described in this chapter and have 
performed a successful request, HiFusion displays the following information:
 "PSM" tab, displays the creation, edition, and identification parameters.
 "Device" tab, displays the detected device and the associated SysOID.
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 "Properties" tab, displays the detected device properties.
 "Traps" tab, displays the detected traps.
 "Translations" tab, displays the English descriptions of the traps.
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5.2 Define basic parameters

This chapter describes how to define basic parameters of your PSM, for 
example, the name of the device. The "PSM" tab contains the basic 
parameters referred to in this chapter.

You have carried out the steps described in the previous chapter.

To define basic parameters of your PSM, you proceed as follows:
 Open the "PSM" tab.
 Specify the internal name of the PSM.
 Enter the visible name of the PSM.
 Enter the description of the PSM.
 Enter the copyright of the PSM.
 Enter the author name of the PSM.
 Enter the manufacturer name.
 Enter the version of the PSM.

Note: If you have forgotten a parameter in a mandatory field, HiFusion 
reminds you of the empty field when you use the "Check PSM" or "Test PSM" 
function.
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5.3 SysOID and image

After HiFusion loads the MIB variable values of a device, the System Object 
Identification (SysOID) of this device is shown here. You can change the 
SysOID and the device icon (image) in the "Device" tab. Changing the 
SysOID allows you to create PSMs for entire device groups.

HiFusion allows you to change the SysOID. Delete numbers from the existing 
SysOID allows you to create device groups. 

If the SysOID you have entered ends with a point, this entry is valid for the 
devices whose SysOID begins with the value in front of the point for example:
 SysOID of device family: 1.3.6. ... .10
 Device A: 1.3.6. ... .10.2
 Device B: 1.3.6. ... .10.3
 Device C: 1.3.6. ... .11.5
 Devices A and B are within the range of the PSM, and device C is outside 

of the range.

5.3.1 Add a SysOID and image to the PSM

HiFusion allows you to add a SysOID and an image. When you select a 
representative image for every device family of a manufacturer, this 
increases the recognizability in Industrial HiVision. The images in HiFusion 
have the dimensions 64 px × 64 px. When you install HiFusion, numerous 
icons are available to you in various categories. 

To add a SysOID and an image, you proceed as follows:
 Open the "Device" tab.

The tab displays the product name, the SysOID, the SNMP access 
parameters, the management protocols, and supported protocols of your 
device.

 Click "Add".
HiFusion opens the "Device identification" window.

 Enter the SysOID and the product name.
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 Click "Select".
HiFusion opens the "Select" window.

 Navigate to the image of your choose. To enlarge the image, click on it.
 Highlight the image.
 Click "Select".

HiFusion now displays the image in the "Device identification" dialog.
 Click "OK".

HiFusion displays the changes in the table of the "Device" tab.

Note: Assign an image to the SysOID(s).

5.3.2 Changing the SysOID and image

When you select a representative image for every device family of a 
manufacturer, this increases the recognizability in HiFusion. Images in 
HiFusion have the dimensions 36 px × 36 px.

If you have not assigned an image to the SysOID(s) so far, perform this step 
now. If you have already assigned an image, HiFusion allows you to replace 
the image. If you only intend to assign or replace an image, you leave the 
SysOID and the product name unchanged. If you do not intend to replace the 
image, skip to the relevant step.

To change the SysOID and replace the image, you proceed as follows:
 Open the "Device" tab.

The "Device" tab displays the identification and images, the SNMP 
access parameters, and the protocols of your device.

 Select the row to edit in "Identification and Images" table.
 Click "Edit".

HiFusion opens the "Device identification" dialog.
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 Change the SysOID.
 You can use any MIB variable for additional device identification, 

however, using sysDescr.0 is recommended. Marking the "Additional 
device identification" checkbox activates the following fields:
– MIB Variable
– Instance
– Value
– Vendor

Use the following steps to assign or replace an image:
 Click on the image.

HiFusion opens the "Select image" window.
 Navigate to the image of your choose.
 Select the image.
 Click "Select".

HiFusion displays the file name of the new image next to "Image" in the 
"Device identification" dialog.

The last work step completes the process and enters the changes in the PSM 
project.
 Click "OK".

HiFusion displays your changes in the table.

5.3.3 Deleting the SysOID

To delete an entry from the table, you proceed as follows:
 Select the row.
 Click "Delete".

HiFusion deletes the entry from the list.
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5.4 Define properties

HiFusion allows you to assign multiple properties to every PSM. In turn, you 
assign to every property a MIB variable, which you then configure according 
to your requirements.

The prerequisite for completing the work steps in this chapter is that you have 
carried out the work steps described in the previous chapters. 

5.4.1 Create or remove a property

When you create a PSM in HiFusion, the program displays the discovered 
properties device tree (left side panel) of the "Properties" tab. You can add a 
property to the PSM project as long as the associated MIB is available in the 
same project.

To create a new property, you proceed as follows:
 Open the "Properties" tab.
 Right-click a property or folder in the property tree.
 Select New property from the drop-down list.

HiFusion opens the "Input" window.
 Enter the name of the property in the New property field.
 Click "OK".

HiFusion creates the new property as a sub-property in the device tree.

After you create the new property, you can configure the PSM to display a 
specific attribute in the "Devices" tab of Industrial HiVision.

To have the PSM display the desired attribute in Industrial HiVision, you 
proceed as follows:
 Select the new property in the property tree.
 In the "Property type" field, mark the "Bind to" checkbox.
 Select the desired attribute from the "Bind to" drop-down list. You can 

select from the following attributes:
– chassis number
– serial number
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– firmware version
– MAC Address
– Configuration Signature

Note: You can specify only 1 attribute per property.

Optional: to select an image for the property, you proceed as follows:
 Select the property that you want to edit in the device tree.
 In the "Properties type" frame, next to the "Image" text field, click "Select".
 Navigate to the folder containing your image.
 Select the image.

The window displays a larger image allowing you to verify that you 
selected the proper image.

 Click "Select".
HiFusion displays the file name of the image in the "Image" field.

To remove a property, you proceed as follows:
 Right-click a property or folder in the device tree.
 Select "Remove" from the drop-down menu.

HiFusion opens the "Remove" message window.
 Click "Yes".

HiFusion deletes the property from the device tree.

5.4.2 Available Features

In addition to the information imported into the MIBs tab, your PSM can 
contain other information about the device. The Features frame of the 
Properties tab allows you to select what device information your PSM 
contains.
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Note: Verify that the MIB values are correct for your PSM after MIB 
importation.

 The Standard MultiConfig™ Dialogs Feature
After you create and import a PSM into Industrial HiVision, Industrial 
HiVision allows you to specify the basic parameters. Basic parameters 
are, System Name, System Location, and System Contact information.

The Standard MultiConfig™Dialogs feature allows you to include 
additional dialogs in the PSM. When you activate the feature, the PSM 
includes the following dialogs and properties.
 Switching> Global dialog

– Aging time
 Switching> Multicast> GMRP dialog

– GMRP
 Switching> VLANs> Table

– VLAN ID
– VLAN name
– GVRP

 Redundancy> Rapid Spanning Tree dialog
– Version
– Priority
– Hello Time
– Forward Delay
– Maximum Age
– Tx Hold Count

 Diagnostics> Status Configuration> Global dialog
– Authentication Trap

 Port -> Port Configuration -> Manual configuration dialog
 Port -> Port Configuration -> Automatic configuration dialog

– Autonegotiation
 Port -> Port Prioritization dialog

– Priority
 Port -> Rapid Spanning Tree dialog

– Stp Active
– Port Path Cost
– Port Priority
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– Admin Edge Port
– Auto Edge Port

 Port -> VLANs -> Settings dialog
– Port VLAN ID
– GVRP
– Ingress Filtering
– Acceptable Frame Types

Note: If you create a new PSM in HiFusion and activate the Standard 
MultiConfig™ Dialogs feature, then the dialogs are displayed in Industrial 
HiVision after you import the PSM. This way you can configure other third 
party devices using the same PSM.

5.4.3 Add a MIB variable to a property

In order for the PSM to display information associated with the property in 
Industrial HiVision, the PSM searches the device for the MIB variable and 
retrieves the information contained in the device. 

To create a MIB variable for the new property, you proceed as follows:
 Select the property that you want to edit in the device tree.

HiFusion displays the name and the token for the property.
 In the "Properties type" frame, next to the "MIB Variable" text field, click 

"Select".
HiFusion opens the "MIB variable selector" dialog.

 In the search field you enter the name of the MIB variable, part of the 
name, or a search term.

 Double-click the row in the table.
HiFusion displays the name of the selected MIB variable in the "Properties 
type" frame, "MIB variable" text field.
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5.4.4 Reconfigure MIB variables

In order to tailor MIB variables to your requirements, HiFusion allows you to 
reconfigure and change the content in the MIB variables.

The following options are available to you:
 convert the values of a MIB variable,
 create mapping,
 create status configuration.
Additionally, HiFusion allows you to perform many other settings on the 
"Properties" tab.

Note: The selection in the "Data type" field restricts or expands your options 
for the following input fields in the "Properties" tab. Industrial HiVision 
proposes a data type for the selection of a MIB variable. You only change the 
data type if you know that the variable has another data type.

 Convert figures
HiFusion allows you to convert values linearly (y = a × x + b). An example 
of such an operation is the conversion from °C to °F. 

This example defines the values for temperature conversion:
 Factor = a = 1.8
 Offset = b = +32
 Value in the agent = x, for example, 50 °C
 Value in HiFusion = y
When you enter the values in the equation, y = 1.8 × 50 + 32 = 122, 
Industrial HiVision returns the value output: 122 °F.

 Create mapping
Some values defined in the MIB variable are numerical. In order to create 
a meaningful output of the values HiFusion allows you to map the output 
to a word.
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This is an example of mapping using the ifAdminStatus variable:
 Output from the agent = 1

Meaning = up
 Output from the agent = 2

Meaning = down
 Output from the agent = 3

Meaning = testing
The mapping assigns the meaning to the numeric value.

Note: If you have loaded the relevant MIB for the MIB variable, Industrial 
HiVision creates the mapping automatically for MIB variables of the Enum 
type.

 Create status configuration
When you select the data type option, HiFusion allows you to specify a 
particular status configuration. The status configuration allows you to 
specify parameter condition monitoring. 

The following list displays which data type HiFusion associates with which 
status configuration:
 String: comparison with a reference text.
 Integer: comparison with upper and lower thresholds.
 Float: comparison with upper and lower thresholds.
 Enumeration: a status can be assigned to every possible value.
 MAC Address: comparison with a reference text.
 IP Address: comparison with a reference text.

The following list describes the procedure for the status configuration of 
an integer data type:
 Mark the "Advanced settings" checkbox.
 Mark the "Status configuration" checkbox.
 Click "Edit".

HiFusion opens the "Status configuration" dialog.
 In "Threshold 1:" enter 10.
 In "Threshold 2:" enter 40.
 Using the drop-down menu next to the "Value Below threshold 1:" text 

field, select Error.
 Using the drop-down menu next to the "Value Below threshold 2:" text 

field, select Warning.
60
PSM Generator Industrial HiVision

Release 04.5.00 03/2024



Creating a PSM 5.4 Define properties
 Using the drop-down menu next to the "Value Below threshold 3:" text 
field, select OK.

 Click "OK".
You return to the "Properties" tab.

Now when Industrial HiVision monitors the property, it displays the icon 
background in the various colors depending on the actual value in the 
device.
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5.5 Save a PSM project

Undoing changes to the PSM project can sometimes be difficult, or cause a 
lot of work. For this reason, save the project often. 

HiFusion gives you the following options to save a PSM project:
 Save as
 Save

Note: If you only generate the PSM you no longer have the option of editing 
the PSM. If you save the PSM project you still have this option. Similarly, 
anyone to whom the PSM project is available can edit the PSM project. You 
can save the project by generating a PSM. HiFusion saves the project with 
the correct file name and the version number appended. Start with a version 
number of 001, and increment the version number after every save, so that 
you can go back to a previous version. Reserve 100 for the final version.

5.5.1 Save as

The "Save as" option allows you to save your project in a specific location. 
 When saving the project for the first time, click File> Save as.

HiFusion opens the "Select location for saving" window allowing you to 
navigate to a particular location and save your project.

 When subsequently saving the project, click File> Save (Ctrl+S).
Saves your PSM project in the previously selected location.
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5.5.2 Save

When you save your PSM project for the first time, HiFusion follows the same 
procedure as for Save as. Otherwise, Save (Ctrl+S) saves your PSM project 
in the last location used.
 Click File> Save (Ctrl+S). 

You have saved your PSM project.
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5.6 Create translations (optional)

The "Traps" tab displays the SNMP traps that HiFusion imported when you 
loaded the project load. The imported traps contain the English descriptions 
for the traps as seen in the "Translations" tab. HiFusion allows you to change 
the English descriptions and create descriptions for the other languages. 

The prerequisite for editing the descriptions is that you have carried out the 
steps described in the previous chapters.

To create a description or descriptions for the various languages, you 
proceed as follows:
 Open the "Translations" tab.
 To edit descriptions for a single language or multiple languages, in the 

right-side panel, mark the "Use" checkbox for each required language.
HiFusion creates a column in the table for each language selected.

 Select the row with the description that you want to translate.
 Click "Edit".
 Fill each empty field with the trap description.
 Click "Save".

HiFusion displays your description in the table.

Note: Fill in every empty field. Otherwise, HiFusion detects a warning and 
displays a message, and HiFusion aborts the PSM creation.
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5.7 Check and test the PSM

After you enter the necessary information to create a basic PSM, the next 
step is to check the PSM to verify that the required information is indeed 
present in the PSM. HiFusion detects and displays any mistakes or missing 
information. 

After creating a PSM, HiFusion allows you to verify the contents of PSM 
project with the following options:
 Check PSM
 Test PSM

The prerequisite for checking the PSM project is that you have carried out the 
steps described in the previous chapters.

5.7.1 Checking the PSM

HiFusion checks whether you have filled the mandatory fields. HiFusion also 
checks whether the values entered fulfill the specifications for example, no 
spaces in the PSM name. You get feedback from the program in the "Errors 
and Warnings" window. The window displays the detected missing 
information or mistakes found during the check. Furthermore, HiFusion 
automatically checks the PSM before creating a PSM project.

The message window displays information about the following detected error 
conditions:
 the severity of the error or warning,
 the location of the error or warning,
 the reason for the error or warning.
HiFusion allows you to check the PSM at any time. When saving the PSM, 
HiFusion automatically performs a check.
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To check the PSM, you proceed as follows:
 Click PSM> Check PSM.

HiFusion opens a message window which displays the results of the 
check.

 When HiFusion displays the message window "No errors or warnings 
found", click "OK". The PSM project is ready for testing.

 If HiFusion displays the "Errors and Warnings" window, change the 
entries accordingly and recheck the PSM.

5.7.2 Testing the PSM

For the testing the PSM project, HiFusion starts a test environment similar to 
Industrial HiVision. HiFusion loads the PSM into this test environment.

The following options are available to test the PSM:
 Virtual test environment

HiFusion accesses data stored in the PSM project and simulates the 
Industrial HiVision program:
– "Internal agent": the agent simulated by HiFusion only supports 

SNMPv1. This means the SNMPv3 always displays the agent as 
unreachable.
Furthermore, the MIB of the simulated agent is a snapshot, the MIB 
values are static.

– "Custom agent dump": allows you to test a MIB dump of a device from 
the same family.

 Directly on the device
When the device that the PSM represents is available in the network, 
HiFusion allows you to enter the IP address of the device so that you can 
test the PSM directly on the device.

 Test PSM with the internal agent
To test the PSM with the internal agent, you proceed as follows:
 Click PSM> Test PSM.

HiFusion opens the "Test PSM" window.
 Verify that the "Virtual device" radio button is active (default: active).
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 Verify that the "Internal agent" radio button is active (default: active).
 Click "Test".

HiFusion opens the "Loading test kernel" message, and checks your 
PSM. After HiFusion completes the check, the "Kernel" dialog opens. 
The dialog displays your properties in the same position on the device 
tree as when you created them. At this time note the IP address and 
SNMP Port number. You use the information later when importing the 
PSM into Industrial HiVision.

 Click “Close”.
HiFusion returns you to the program window.

 Test PSM with an external agent
To test the PSM on an actual device, you proceed as follows:
 Click PSM> Test PSM

HiFusion opens the "Test PSM" dialog.
 Click the "IP of real device" radio button.

HiFusion activates the IP address text field.
 Enter the IP address of the relevant device.
 Optional: Click "Port" and enter a port number.
 Click "Test".

HiFusion opens the "Loading test kernel" message, and checks your 
PSM. After HiFusion completes the check, the "Kernel" dialog opens. 
The dialog displays your properties in the same position on the device 
tree as when you created them. At this time note the IP address and 
SNMP Port number. You use the information later when importing the 
PSM into Industrial HiVision.

 Click "Close".
You return to the program window.

HiFusion retrieves the values displayed in the "Kernel" dialog directly from 
the device. To change the values in the "Kernel" dialog, you can change 
any value in the device and conduct a "Rescan".
PSM Generator Industrial HiVision
Release 04.5.00 03/2024 67



Creating a PSM 5.8 Generating a PSM
5.8 Generating a PSM

Generating a PSM allows you to incorporate the device into the Industrial 
HiVision network management system. Whenever Industrial HiVision 
discovers the relevant device, Industrial HiVision uses the PSM to display the 
device information.

The prerequisite for generating the PSM is that you have carried out the 
steps described in the previous chapter.

To generate a PSM, you proceed as follows:
 Click PSM> Generate PSM.

HiFusion checks the PSM and returns an error message if a field has 
been filled incorrectly.
HiFusion opens the Generator Settings window.

 Optional: To only create the PSM, remove the mark from the "Save PSM 
project" checkbox.

 Optional: Select a path for the location to which the program saves the 
PSM project.
The file is saved as a zip file. It is strongly recommended that you do not 
change the file name. The digits at the end of the file name are the digits 
you entered as the PSM version number.

 Select a path to which the program saves the PSM.
It is strongly recommended that you do not change the file name, as 
Industrial HiVision uses this naming format and file extension. 

 Click "Generate".
HiFusion opens the "Message" window. You receive a message stating 
that HiFusion has successfully created the PSM.

 Click "OK".
You return to the program.
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5.9 Change an existing PSM

HiFusion allows you to change existing PSMs so that you can create different 
PSMs for other devices.

The prerequisite for changing an existing PSM is that you have a PSM, and 
the required MIBs saved locally. 

To change an existing PSM project, perform the following steps:
 If you already have the HiFusion program open, then click File> Open. 

Otherwise, open the HiFusion program, click Open an existing PSM.
HiFusion opens the Open PSM project window

 Navigate to your existing PSM project.
 Click "Open".

You see the various entries on the various tabs.
 Edit the PSM project according to your requirements.
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5.10 Make MultiConfig™ dialogs 
for PSMs

The MultiConfig™ tab allows you to make a MultiConfig™ dialog that 
HiFusion saves in the PSM. If your PSM includes the MultiConfig™ dialog, 
then you can use MultiConfig™ to configure several devices at the same 
time.

5.10.1 Create or remove a MultiConfig™ dialog

HiFusion allows you to change and remove the MultiConfig™ dialogs when 
your device changes. 

Note: The port configurations do not work for devices with modules.

To define a new dialog in the MultiConfig™ tree for a PSM you previously 
defined, proceed as follows:
 To create a new property node for devices, in the “Configuration” tree, 

right-click the “Device settings” object. To create a new property node for 
ports, right-click the “Port” object.

 Click the “New Property” option.
 Enter the name of the dialog.
 Click the “OK” button.

After you click the “OK” button, HiFusion opens the dialog.
 To configure the new property, click the “Add config” button.
 In the first blank text field, enter a label name for the property. HiFusion 

automatically generates and adds the token in the “Translations” tab.
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 In the second blank text field, enter the MIB variable for the property.
Optional: To select a MIB variable from the MIB variable selector, click the 
“Select” button.

 Select the property type from the drop down list:
 Integer
 String
 Boolean
 Option

 Click the “Select” button.
HiFusion opens the “MIB variable selector” dialog
 In the “Search” field, you enter the name of the MIB variable, part of 

the name, or a search term.
 Double-click the row in the table.
HiFusion displays the name of the selected MIB variable in the “MIB 
variable” text field.

 To remove a property from the MultiConfig™ tree, proceed as follows:
 Right-click the dialog that you want to remove in the “Configuration” tree.
 Click the “Remove” button.
HiFusion deletes the entry from the MultiConfig™ tree.

5.10.2 Change the dialog icon

When you select a representative image for every property, this increases 
the recognizability in HiFusion. Images in HiFusion have the dimensions 
36 px × 36 px.
To assign or replace an image, use the following steps:
 Right-click the property.
 Select the “Edit Image” option.

HiFusion opens the “Select” dialog. 
 Navigate to the image you wish to change.
 Highlight the image, click the “Select” button.
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5.10.3 Import a dialog from another PSM

To import a dialog from another PSM to the MultiConfig™ tree, proceed as 
follows:
 Right-click the “Device settings” object or “Port” object in the 

“Configuration” tree.
 Click the “PSM Import” button.

HiFusion opens the “Open” dialog.
 Navigate to the property that you wish to import.
 Select the property, click the “Open” button.
 Navigate to the property that you wish to import.
 Select the property, click the “Open” button.
72
PSM Generator Industrial HiVision

Release 04.5.00 03/2024



Index
A Index
F
FAQ 77

M
MIB Variable 55

S
System requirements 10

T
Technical questions 77
Training courses 77
PSM Generator Industrial HiVision
Release 04.5.00 03/2024 73



Readers’ Comments
B Readers’ Comments

What is your opinion of this manual? We are always striving to provide as 
comprehensive a description of our product as possible, to help ensure 
trouble-free operation. Your comments and suggestions help us to further 
improve the quality of our documentation.

Your assessment of this manual:

Did you discover any errors in this manual? 
If so, on what page?

Very good Good Satisfactory Mediocre Poor
Precise description O O O O O
Readability O O O O O
Understandability O O O O O
Examples O O O O O
Structure O O O O O
Completeness O O O O O
Graphics O O O O O
Drawings O O O O O
Tables O O O O O
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Suggestions for improvement and additional information:

General comments:

Sender:

Dear User,

Please fill out and return this page 

 as a fax to the number +49 (0)7127 14-1600 or
 by post to 

Hirschmann Automation and Control GmbH
Department 01RD-NT
Stuttgarter Str. 45-51
72654 Neckartenzlingen

Company / Department: 

Name / Telephone no.: 

Street: 

Zip code / City: 

e-mail:

Date / Signature: 
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C Further support

Technical questions

For technical questions, please contact any Hirschmann dealer in your area 
or Hirschmann directly.

You find the addresses of our partners on the Internet at
https://www.belden.com.

A list of local telephone numbers and email addresses for technical support 
directly from Hirschmann is available at
https://hirschmann-support.belden.com.

This site also includes a free of charge knowledge base and a software 
download section.

Customer Innovation Center

The Customer Innovation Center is ahead of its competitors on three counts 
with its complete range of innovative services:

 Consulting incorporates comprehensive technical advice, from system 
evaluation through network planning to project planning.

 Training offers you an introduction to the basics, product briefing and user 
training with certification.
You find the training courses on technology and products currently 
available at https://www.belden.com/solutions/customer-innovation-
center.

 Support ranges from the first installation through the standby service to 
maintenance concepts.

With the Customer Innovation Center, you decide against making any 
compromises in any case. Our client-customized package leaves you free to 
choose the service components you want to use.

Internet:
https://www.belden.com/solutions/customer-innovation-center
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